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    

1. Combination Scale Factor 
a. The CSF will be neglected for transverse measurements. 
b. All bridge span lengths and stations in Infaworks will be grid dimensions. 
c. All Inventor items will be built using ground dimensions. 
d. Additional notes required to denote what is grid and what is ground 

i. May need dual models for some scenarios when girders need to be in ground 
dimensions 

2. Dimensions and Notes 
a. All dimensions and notes will be placed in “Paper Space” at a 1:1 scale. 
b. Standard details will be placed in “Paper Space” at the correct scale. 

i. If detail needs modification place in Model Space at 1:1 scale and modify 
accordingly and place on sheet the same as any other detail. 

c. Borings placed on Revit sheet at 1” = 20’-0”. 
3. Microstation to ACAD line weights 

a. MS 0 = ACAD 0.09 
b. MS 1 = ACAD 0.18 
c. MS 2 = ACAD 0.25 
d. MS 3 = ACAD 0.30 

4. Greyscale Colors 
a. 250 – 255 

i. These will plot as their respective shades of grey 
5. Sheet Size 

a. All Autodesk sheets will be 11x17 (Autocad & Revit). 
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    

PROJECT FILES 

ACAD_Template.dwt     S:\Bridge_CADD\Autodesk\Civil_3D\Templates 

• Autodesk Drawings (Rehab) 
• Details for Revit Import 

 

ACAD_DeckGrid_Template.dwt    S:\Bridge_CADD\Autodesk\Civil_3D\Templates 

• Autodesk Drawings (Deck Grids) 

 

Sheet Set Template.dst     S:\Bridge_CADD\Autodesk\Civil_3D\Templates 

• Sheet Sets for Autocad Drawings (Rehab) 

 

Deck Grids Sheet Set Template.dst   S:\Bridge_CADD\Autodesk\Civil_3D\Templates 

• Sheet Sets for Autocad Drawings (Deck Grids) 

 

C3D_Template.dwt     S:\Bridge_CADD\Autodesk\Civil_3D\Templates 

• Alignments for Infraworks 
• Terrain for Infaworks and Revit 
• Borings for Revit 

 

XXXX000BRDSNTB1.dwg    S:\Bridge_CADD\Autodesk\Civil_3D\Templates 

• Tables for Revit Projects 
o One file for each bridge on the project 

 

Bridge_061820.rte     S:\Bridge_CADD\Autodesk\Revit\Templates 

• Revit Projects 

 

STANDARD DRAWINGS 

• PDF: BR_ Std_Dwg_Binder   S:\Bridge_CADD\StdDwg\PDF 
• CAD:  BR_Std_Dwg.dwg   S:\Bridge_CADD\StdDwg\CAD 
• Sheet Set: BR_Std_Dwg_Set   S:\Bridge_CADD\StdDwg\CAD 
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    

The following guide is for placing Autodesk Bridge Models and Design Files on BIM360. 

1. Create a “Bridge Model” folder in BIM360 in the “BR” folder under the project: 
a. This will be where the CADD files for the bridge model will be store 

2. Create the following folders in the “Bridge Model” folder depending on the project type 

 

 

INVENTOR 
1. Copy the “Inventor Template Folder” to Inventor folder under the project on BIM360 
2. Rename the folder accordingly based on the object created 

a. 3D Model Filename: XXXX000BRXXX001 (File class to be named per the object ex. BNT, 
PRD, RDE) 

3. Create the Inventor parts and assemblies as needed for the object in this folder 
a. 3D Model Filename: XXXX000BRXXX001.IPT (File class to be named per the object ex. 

BNT, PRD, RDE) 
4. Export the part or assembly to the “IW_Export” Folder 

 

INFRAWORKS 
1. Created with “Model Builder” 

a. Locate the Infraworks files 
i. Location: C:\Users\uXXXX\Documents\Autodesk InfraWorks Models\Autodesk 

360\716977 
ii. The “716977” folder is a random number, located in this folder will be another folder 

and a *.sqlite file with a name matching the filename given in Infaworks when the 
model was created. 

b. Move the folder and the *.sqlite file to BIM360 
i. Folder Filename: XXXX000BRMAP001 
ii. Filename: XXXX000BRMAP001.SQLITE 

1. The *.sqlite file and the accompanying folder must have the same filename 
2. Created from scratch 

a. Save the file to the Project Infraworks folder on BIM360 
i. Use the above filename for the file 

 

New Bridge Rehab 
Inventor Autocad 
Infraworks  
Revit  
Civil 3D  
Autocad  
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REVIT 
1. Place Revit file on BIM360 

a. Filename: XXXX000BRRVT001.RVT 

 

CIVIL 3D 
1. Place Civil 3D files on DMS 

a. Terrain Filename: XXXX000BRETR001.DWG 
b. Alignment Filename: XXXX000BRALN001.DWG 
c. Borings Filename: XXXX000BRCOR001.DWG 
d. 3D Bridge Filename: XXXX000BRGEN001.DWG 

i. This file will contain the Revit or Infraworks export for Road Design Plans 
e. Map File Filename: XXXX000BRMAP001.DWG (Contains XREF of the above files) 

i. The Map file is only needed if required by design. 

 

AUTOCAD 

1. Place Autocad file on BIM360 
a. 3D Model Filename: XXXX000BRXXX001.DWG (File class to be named per the object ex. 

BNT, PRD, RDE) 
b. Rehab Filename:  XXXX000BRREH001.DWG (Only one file per Rehab, All sheets in this file) 
c. Tables Filename: XXXX000BRDSNTB1.DWG 

2. Place Civil 3D export to Autocad on BIM360 
a. Terrain Filename: ACAD-XXXX000BRETR001.DWG 
b. Alignment Filename: ACAD-XXXX000BRALN001.DWG 
c. Borings Filename: ACAD-XXXX000BRCOR001.DWG 

 

SHEET SET 
1. Place Autocad Sheet Set file on BIM360 

a. Sheet Set Filename: XXXX000BRREH001.DST 
i. The sheet set is only required for Autocad Rehab projects. 

1. The filename should match the Autocad filename. 
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    

The following guide is to get OpenRoads alignments and terrain into Autodesk for bridge modeling. 

Download the following road design files from DMS 

• XXXX000XXALN001.DGN (OpenRoads Alignment file) 
• XXXX000XXETR001.DGN (OpenRoads Terrain file) 

 

OPEN ROADS 

TERRAIN EXPORT 

Open the XXX000XXETR001.DGN file in OpenRoads 

• Select the terrain boundary line 
• Hover mouse over selected boundary line until 

dialog box pops up 
• Expand the 3rd Option from the left (Export Terrain 

Model) 
• Select LandXML Export 

 

Enter the appropriate values in the Next 3 dialog box popups at the cursor. 

Enter a Project Name  

Left Click to accept 

 

Enter a project description 

(This may be left blank) 

Left Click to accept 

 

Verify “Export Both” is the current value 

Left Click to accept 

 

Save the file to BIM360 in the Civil 3d folder with the following filename 

Filename: XXXX000BRETR001.XML 

 

 



 
April 23, 2020 

 

        

ALIGNMENT EXPORT 

Open the XXX000XXALN001.DGN file in OpenRoads 

• Select the alignment 
• Hover mouse over selected alignment until 

dialog box pops up 
• Expand the 4th Option from the right 

(Horizontal Geometry Report) 

 

 

Select “AlignmentsToLandXML.xsl” from the 
CivilGeometry folder (This should be the first 
option in the list) 

 

 

 

 

 

 

Do a File > Save As 

 

Save the file to BIM360 in the Civil 3D 
folder with the following filename 

New Filename: XXXX000BRALN001.XML 

 

LEAVE THE “Save as type” SET TO 
“Text File (*.txt)” 
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CIVIL 3D 

Create a new file from the Template: C3D_Template.dwt 

Save the new file as: 

• Alignment: XXXX000BRALN001.DWG 
• Terrain: XXXX000BRETR001.DWG 

TERRAIN IMPORT 

Open the XXXX000BRETR001.DWG file 

 

From the “Insert” tab select “LandXML”  

 

Select the XXXX000BRALN001.XML created above from 
BIM360 

 

 

 

 

Verify the Import LandXML dialog box matches 
what is shown here 
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ALIGNMENT IMPORT 

Open the XXXX000BRALN001.DWG 

From the “Insert” tab select “LandXML” 

 

Select the XXXX000BRALN001.XML created above from 
BIM360 

 

 

 

Verify the Import LandXML dialog box matches what is shown 
here 
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INFRAWORKS 

Create a new file or open an existing file 

New Filename: XXXX000BRMAP001  (There is no file extension when creating Infraworks files) 

 

The initial model will need its model properties set for the proper coordinate system  

 

Select the “Model Properties” from the “Model” tab 

 

 

 

 

 

 

 

 

Expand the USC box and Select the 
MT83IF coordinate system 

 

If this option is not available 

Select the “Globe” icon and scroll 
down and select the following 

• USA, Montana 
o MT83IF 
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TERRAIN IMPORT 

Open the “Data Source” toolbox 

 

 

 

 

 

 

 

Add a data source by “Autodesk Civil 3D DWG” 

 

 

 

 

Select the terrain file XXXX000BRETR001.DWG created in the 
Civil 3D Terrain import section. 

 

 

This data source now needs to be configured. 

 

Double click on the 
newly added data 
source 

Change the 
coordinate system 
to MT83IF 

 

Select Close and Refresh at the bottom of this box when finished 

 

The terrain is now loaded into the model. 
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ALIGNMENT IMPORT 

Open the “Data Source” toolbox 

 

 

 

 

 

Add a data source by “Autodesk Civil 3D DWG”  

 

 

 

 

Select the alignment file XXXX000BRMAP001.DWG created in 
the Civil 3D alignment import section. 

 

 

 

 

 

 

 

This data source now needs to be configured. 

Double click on the 
newly added data 
source 

Change the 
coordinate system 
on the “Geolocation” 
tab to MT83IF 
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Click on the style chooser on the 
“Common” tab > Style Section > Assembly 
Style 

 

 

 

 

Browse to the style 

Component/Assembly/Two Lanes and 
press OK 

 

Currently the “Two Lanes” style comes into 
the model as 4 Lanes. Just use the outside 
2 lanes as shoulders or delete them based 
on the needs of the model. 

 

 

 

 

 

Select Close and Refresh at the bottom of this data source configuration when finished 

 

The alignment is now loaded into the model. 
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    

The following guide is to get Civil 3D Terrain into Revit. 

Download the following files from DMS 

• XXXX000BRETR001.DWG (Civil 3D Terrain file) 

 

CIVIL 3D 

TERRAIN EXPORT 

Open the XXX000BRETR001.DWG file created in the “Openroads Road Data to Autodesk” Guidance 

 

• Select the terrain 
• From the “Tin Surface” tab select Surface Properties from 

the Modify panel. 
• Choose “Edit Surface Style” 

 

 

 

• On the display tab turn off all “Components” except triangles 
o Verify “Triangles” are on a layer that is NOT 0 

 

Your file should show the terrain as triangles only 

 

• Export the file to DWG (This will strip all Civil 3D data from the file) 
• Select the appropriate Destination folder for the new file 
• Filename: ACAD-XXXX000BRETR001-Model.DWG 

o The “ACAD_” prefix and the “-Model” suffix will be 
automatically applied in the export dialog box 

• Uncheck all layouts, so only the model is exported 
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AUTOCAD 

REFERENCE MARKER 

Open the ACAD-XXXX000BRETR001-Model.DWG file previously exported 

 

Remove any objects or triangles that are not required by simply deleting them. 

If it is determined the whole terrain area is not required for the bridge project remove the excess triangles 
and the associated points and labels. 

 

Locate a marker a known coordinate location in the file 

• Note the coordinates of the marker 
o They will be required for use in Revit later to align the terrain to the bridge 

• Locate the marker near the bridge location but out of the area required for the plans 

 

 

 

REVIT 

TERRAIN IMPORT 

Open the Revit file XXXX000BRRVT001.RVT containing the bridge model 

 

• On the Insert tab select “Link CAD” 

 

 

 

 

• Link to the ACAD-XXXX000BRETR001-Model.DWG 
file from the Terrain Export section of this guidance 

• Positioning: Auto – Origin to Origin 
• Place at: Terrain 
• Import Units: Auto-Detect 
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• Move the terrain from its current location to near the bridge model 
o It will be placed near the survey point in the “Site” Level 

• Modify the survey point coordinates to match the coordinates noted above 
• Align the marker in the linked file with the survey marker 

 

TOPOGRAPHY 

• From the “Massing & Site” tab select Toposurface 

 

 

• In the Modify | Edit Surface tab select “Select 
Import Instance” from the “Create form Import” 
Tool 

• Select the ACAD-XXXX000BRETR001-
Model.DWG triangles that were imported 

 

 

 

 

• Uncheck all items except “Triangles” 
• Select “OK” to load the topography 

 

• Select Finish Surface 

 

 

 

 

The Surface will now need cleaned up due to Revit creating additional triangles around the perimeter for the 
terrain 

 

• Select the surface and choose “Split Surface” from the 
Massing & Site tab and select the Revit surface 
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• Using the line tool place a chain around the 
linked terrain to form a closed boundary 
 

• Select Finish Surface when Done 
 

This will create 2 separate surfaces.   

• Delete the surface that contains the extra contours 
o This may need to be done multiple times to split all the excess triangles for the required 

surface  
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    

The following guide is to get Autocad Tables into Revit. 

AUTOCAD 

CREATE TABLES 

Copy the XXX000BRDSNTB1.DWG file to your working folder 

• Delete any tables not required for the project 
o This is not necessary 

• Create any new tables required for the project 
o Any new tables need to be placed on their own level 

 Begin new levels for table with the prefix “T_” 
 Follow the naming convention of the premade tables for all new tables 

• Modify the existing tables in the file as necessary to meet the project needs 
o Do not modify the size of the “T_Seismic” table 

 This table is sized to fit on the notes sheet and at the same width as the text 
columns 

 

 

REVIT 

TABLE IMPORT 

Open the Revit file XXXX000BRRVT001.RVT containing the bridge model 

• From the View tab, Create panel, Create a new Drafting View 
• In the Drafting View from the Insert tab select “Link CAD” 

 

 

 

 

• Link to the XXX000BRDSNTB1.DWG file containing 
the tables 

• Positioning: Auto – Origin to Origin 
• Import Units: Auto-Detect 

 

All tables in the Autocad file will now show up in Revit 
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• On the Properties pallet select Edit for the Visibility/Graphics 

 

• On the Imported Categories Tab, expand the file that matches the 
tables file 
 

 

 

 

 

• Uncheck all the layers except the for one which has the table you want displayed 
• Select “OK” 

 

To create additional tables from the same Autocad file 

• Select the table in the Project Browser 
• Right Click and Select Duplicate View Duplicate View 

with Detailing 
• Uncheck the appropriate layers to display the correct 

table 

 

When placing the table on the sheet set the following properties 

• Set the viewport to “NO TITLE” 
• Set the Detail Number to a number greater than the number of details 

that will be placed on the sheet 
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    

The following guide is to get Geotech Borings into Civil 3D and Revit. 

Download the following file from BIM360 

• XXXX000BRALN001.DWG (Civil 3D Alignment file) 

Rename the two files received from Geotech per the following 

• File Containing the boring materials and their respective depths 
o Field Geological Descriptions.csv 

• File Containing the boring locations 
o Location Details.csv 

 

CIVIL 3D 

BORINGS IMPORT 

Open the XXXX000BRALN001.DWG file 

Set the Annotation scale to match the scale of the Footing Plan 

 

• On the Geotechnical Module Tab, In the Data Management 
Panel select Connect 

• Verify the dialog box matches what is shown here and Login 

 

PROJECT SELECTION HERE (NOT FINISHED) 

 

 

• From the Data Management Panel select Import 
• The dialog box should match what is shown here 
• Choose Add 
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• Browse to the location of the Geotech *.csv files 
• Select both files and open 
• Select Next 

 

 

 

 

 

 

• Select Next on the Next dialog 
o Both files should now show as valid 

 

 

 

 

 

 

• Select all borings to import into the file 
• Select Next 

 

 

 

 

 

 

• Select Next on this dialog box after reviewing 
the information shown 
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• After the import is complete select Finish 
• You should now see the borings at the correct locations along the alignment 

 

LOG OF BORINGS DETAIL 

Open the Attach the XXXX000BRALN001.DWG file 

• On the Geotechnical Module Tab, In the Profile Panel select Create 

 

 

• The dialog box should populate as shown 
• Verify the correct alignment is shown in the dialog 

box if there are multiple alignments 
• Select Next 

 

 

 

 

 

 

 

• Verify that the Style is “MDT Geology Code” 
• Verify that the borings listed are the borings that are 

required 
o Adjust the buffer to display other borings 

that may be beyond the specified distance 
from the CL Roadway 

• For borings show are not shown but don’t need to be 
placed 

o Click the boring and select Remove 

 

• Click to locate the Profile view of the Borings 
o The insertion point of the Profile view is the lower left corner 
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BORINGS EXPORT FOR REVIT 

• Export the file to DWG (This will strip all Civil 3D data from 
the file) 

• Select the appropriate Destination folder for the new file 
• Filename: ACAD-XXXX000BRALN001-Model.DWG 

o The “ACAD_” prefix and the “-Model” suffix will be 
automatically applied in the export dialog box 

• Uncheck all layouts, so only the model is exported 

 

 

 

 

 

 

 

Rename this newly created file to ACAD-XXXX000BRCOR001-Model.DWG 

Copy this newly created file and rename to ACAD-XXXX000BRCOR002-Model.DWG 

 

In the ACAD-XXXX000BRCOR001-Model.DWG file 

• Locate a marker at the same coordinates as the marker for the terrain 
o See Civil 3D Terrain to Revit for additional marker information 

• Remove the Borings Profile view from the file 

 

The boring locations are now ready for import into Revit 

 

In the ACAD-XXXX000BRCOR002-Model.DWG file 

• Remove all elements except the Profile of the borings 
• All an elevation scale, tracer lines, and any other necessary information to the borings 
• Adjust the lateral locations of the borings in the profile 

o The borings are placed in the Profile at their correct stations with regards to the alignment 

 

The boring logs are now ready for import into Revit 
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REVIT 

BORING LOCATIONS IMPORT 

Open the Revit file XXXX000BRRVT001.RVT containing the bridge model 

 

• On the Insert tab select “Link CAD” 

 

 

 

• Link to the ACAD-XXXX000BRCOR001-Model.DWG 
file from the Borings Export to Revit section of this 
guidance 

• Positioning: Auto – Origin to Origin 
• Place at: Terrain 
• Import Units: Auto-Detect 

 

• Move the borings from its current location to near the 
bridge model 

• Align the marker in the linked file with the survey 
marker 

 

Locate the borings symbol in Revit at the center of the borings and label appropriately in the Footing Plan 
Level Detail 

 

 

LOG OF BORINGS IMPORT 

Open the Revit file XXXX000BRRVT001.RVT containing the bridge model 

• From the View tab, Create panel, Create a new Drafting View 
• In the Drafting View from the Insert tab select “Link CAD” 
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• Link to the ACAD-XXXX000BRCOR002-Model.DWG 
file containing the Log of Borings Detail 

• Positioning: Auto – Origin to Origin 
• Import Units: Auto-Detect 
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    

The following guide is to create new Sheet Sets in Autocad. 

AUTOCAD 

NEW SHEET SET 

Open the Autocad file that contains your sheets 

• Open the Sheet Set Manager 
o Location: View tab 

Palettes palette 

 

 

 

 

• In the Sheet set manager select New Sheet Set 

 

 

 

 

 

 

 

 

• Toggle Example Sheet Set 
• Select Next 

 

 

 

 

 

 

 



 
May 14, 2020 

 

        

 

 

 

• Browse to the location of the Sheet 
Set Template 

• Select Next 

 

 

 

 

 

 

• Give the Sheet set a filename 
o This should match the 

filename of the Autocad 
drawing 

• Browse to the location where the file 
will be stored 

o This should be the same 
location as the Autocad 
drawing 

• Select Next 

 

 

• Select Finish 

 

 

 

 

 

 

 



 
May 14, 2020 

 

        

ADDING SHEETS 

 

• Right Click on the new sheet set and select “Import Layout as 
Sheet” 

 

 

 

 

 

 

 

 

 

• Browse and select your file that contains the 
sheets 

• Select the Autocad layouts that you want to 
add to the Sheet set 

• Select Import Checked 

 

 

NOTE: Only sheets that are not part of a sheet set may 
be added. 

 

NOTE: The sheets will now show up in the sheet list by 
the layout name 
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SETTING PROJECT INFORMATION 

 

• Right Click on the new sheet set and select properties 

 

 

 

 

 

These Properties will fill in the information that is the same for all sheets in the set 

• Under Project Control Fill in the following 
information 

• Project Number 
o This will be the Construction Number 

• Project Name 
 

 

• Under Sheet Set Custom Properties Fill in the 
following information 

• County 
• PE # 

 

• Select OK 
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SETTING SHEET INFORMATION 

 

 

Right Click on a sheet in the set and select properties 

 

 

 

 

 

 

 

These Properties will fill in the information that is the same for all sheets in the set 

• Under Sheet Fill in the following 
information 

• Sheet Title 
o This is what will appear in the 

upper right corner of the title 
block and in the list of drawings 

• Sheet Number 
 

 

• Under Sheet Custom Properties Fill in 
the following information 

• Appropriate Initials and Dates for 
o Checked 
o Designed 
o Drawn 

• STR ID 
• Dwg. No. 

o Leave as “XXXXX” until the 
drawing numbers are assigned 

 

 

• Select OK 
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SETTING SHEET NUMBERS AND TITLES 

 

 

Right Click on the first sheet in the list and select Rename & 
Renumber 

 

 

 

 

Fill in the following information 

• Number 
o This is the sheet number 

for the sheet that will 
appear in the title block 

• Sheet Title 
o This is the title of the sheet 

that will appear in the title 
block 

• Layout name 
o Leave this as is 

 

Do NOT check the Rename layout check box at the bottom 

Press Next to proceed to the next sheet in the list 

Press OK when done numbering and naming the sheets 

 

NOTE: These can also be set under the Sheet Properties with the Sheet Title & Sheet Number fields.  See 
“Setting Sheet Information” section of this guide for additional details. 
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PLOTTING 

 

 

 

 

 

 

 

 

 

 

• Plot full sheet set 
o Right click on the sheet set name  

• Plot single sheet 
o Right click on the sheet that needs plotting 

 

• Select Publish 
o Publish using Page Setup Override 

 Select the required plot style for the set 
• MDT_11x17_Color 
• MDT_11x17_Color_PDF 
• MDT_11x17_Greyscale 
• MDT_11x17_Greyscale_PDF 
• MDT_11x17_Monochrome 
• MDT_11x17_Monochrome_PDF 
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LIST OF DRAWINGS 

 

Right click on the sheet set name and select Insert Sheet List Table 

 

 

 

 

 

 

 

 

 

Change the Title Text from “Sheet 
List Table” to LIST OF DRAWINGS 

 

 

Click Add and a new row will be 
added to the list of columns, this will 
be com the drawing number 

 

 

 

 

Click on the sheet number text of the new row and select “Dwg. No.” from 
the list 

 

Double click the text “Dwg. No.” under the Heading text column and change 
the text to DWG. NO. 
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Make sure the “Dwg. No.” row is selected and click move up to move this row between the “Sheet No.” and 
“Title” rows. 

 

 

 

 

The dialog box should 
match what is shown 
here 

 

 

Click Ok 

 

 

 

Locate a point at which to insert the table 

 

 

Format the table remove the column and row borders and 
set the “Sheet No.” and Dwg. No.” columns to center 
justified.  The column and row borders should show up 
grey it they are turned off 

 

 

 

 

 

 




May 14, 2020 

Deck_Grids.docx 

    

The following guide is to create deck grids in Autocad. 

Each structure will get its own deck grid drawing, sheet set and pdf of the deck grids. 

This procedure will require the detailer to only draw the outline of the bridge with the appropriate centerlines 
and annotations.  Make no other modifications to the file or the sheets. 

AUTOCAD 

Create a new Autocad file 

• Template = ACAD_DeckGrid_Template.dwt 
• Filename = MDT Structure ID 
• Save Location =  

Draft the outline of the bridge 

• Draft the bridge such that the following is met 
o Extreme end of bridge is located on the line Y = 0 

 This will be the end of slab or edge of paving notch 
o Left face of rail is located on the line X = 0 
o All Annotations are within the deck grid boundary boxes 

Any object that extends outside of the boundary boxes will not appear on the sheets 

• Annotate the bridge with the following in model space at a 1” = 5’-0” annotation scale. 

Annotating in model space will allow for copying the required annotations from sheet to sheet. 

The annotation scale will be previously set in the Template 

o CL Roadway 
 Each sheet containing the bridge 

o Face of rail (each side) 
 Each sheet containing the bridge 

o End of slab or Edge of Paving Notch 
 Beginning and end of bridge 

• Draft the bridge using the following layers 
o DG_Centerlines 

 All centerlines used for the bridge (CL Roadway, CL Bents) 
o DG_Slab 

 Outline of the bridge 
o DG_Text-Dimensions 

 All annotations 
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SHEET SET 

Create a new Sheet Set, See MDT Guidance Autodesk Sheet Sets for additional information. 

• Template = Deck Grids Sheet Set Template.dst 
• Filename = MDT Structure ID 
• Save Location =  

Fill in the 6 fields in the “Sheet Set Custom Properties” Section Only.  This information will populate the title 
block on all sheets. 

• Bridge Name 
o Use the name listed in SMS 

• MDT STR. ID 
• NBI Number 
• Route 

o Use the route listed in SMS 
• Ref Point 

o Use the Reference Point listed in SMS 
• Number of Sheets 

o This will be the total number of sheets; this is also the number located in the deck grid 
boundary that is on the last sheet containing the bridge 

Add only the sheets containing the bridge to the sheet set 

• Rename and Renumber 
o Will need to fill in the number box in the dialog 

 All other information to remain as is 
 This will number the sheets correctly in the title block 

Plot the sheet set 

Verify ALL levels are turned on and thawed before plotting 

• Publish 
o Publish using Page Setup Override 

 MDT_DeckGrid_11x17_Greyscale_PDF 
• Save the pdf to the same location as the Autocad file and Sheet Set using 

the structure number as the file name 
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INVENTOR:
Build 3D Bridge Components

INFRAWORKS:
Build 3D Bridge Model

REVIT:
Create & Detail Bridge Plan Sheets

Detailer:  Creates new objects as 
needed

ROAD DESIGN:
Detailer or Engineer:  Receives updated 

information for use in Bridge Model

Detailer:  Imports Alignment and Terrain
& places existing substructure in model

Detailer or Engineer:  Builds a 
Preliminary bridge in a proposal

Detailer merges Master model and 
Engineer's proposals

Detailer:  Performs fine tuning of 
model and exports to Revit

Engineer: Adds proposals 
throughout project for detailer 

incorporation into Master model

Detailer: Finishes detailing not done 
in Infraworks and prepare Preliminary 

plan sheets

Detailer: Create 2D Bridge plan 
sheets from finished model

Detailer:  Imports additional terrain or 
features as necessary for the Bridge 

Model

Detailer:  Modifies existing objects as 
necessary for specific project needs

Engineer:  Modify existing objects as 
necessary for project proposals

STANDARD OBJECTS LIBRARY 
FOR INFRAWORKS

ROAD DESIGN:
Detailer or Engineer: Receives

Alignment and Terrain from Road 

DETAILER: Owns 
the Master Model in 
Infraworks, Civil 3D 

& Revit

ROAD DESIGN:
Detailer or Engineer:  Send Road 

Design Bridge Model for Road Plans

FINAL PLANS

Bridge Plans 
submittal will be in 

PDF form

Infraworks Master Model 
is the only model 
exported to Revit

Detailer:  Export Preliminary Model to 
Revit

HYDRAULICS:
Detailer or Engineer:  Send  Riprap 

layout to Hydraulics for Approval

ROAD DESIGN:
Detailer or Engineer:  Send Road Design 
Preliminary Bridge Model for Road Plans

Detailer: Prepares preliminary plans 
for road and hydraulics approval

Detailer:  Export Preliminary Model to 
Revit

INVENTOR INFRAWORKS REVIT

DETAILER:
Extensive knowledge for 3D object 

creation and modification

DETAILER:
Extensive knowledge for import and export 
of objects and merging proposals and other 

modelling work as necessary

DETAILER:
Extensive knowledge for creation of 
bridge plan sheets from 3D model

ENGINEER:
Minimal knowledge for minimal 3D 

object modification

ENGINEER:
Extensive knowledge for construction 

of 3D Bridge Model

ENGINEER:
Minimal knowledge for review of 

bridge plan sheets

NAVISWORKS

DETAILER:
Minimal knowledge for performing 

clash detection

ENGINEER:
Minimal knowledge for performing 

clash detection

NAVISWORKS:
Perform Clash Detection

(OPTIONAL)

Detailer or Engineer:  Perform Clash 
Detection

2D Paper or PDF Plans Intelligent Information Model

AUTOCAD / CIVIL 3D

DETAILER:
Extensive knowledge for terrain and Bore log 

creation and miscellaneous detailing work

ENGINEER:
Minimal knowledge for terrain and 

Bore log creation

GEOTECH:
Detailer or Engineer: Receives Bore 

log information from Geotech

AUTOCAD / CIVIL 3D:
Create & Detail  Miscellaneous Items

Detailer: Prepares Terrain and 
Borings for Bridge Plan Sheets Detailer: Prepares Miscellaneous 

details not done in revit
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PRIMARY: Engineer

SECONDARY: Detailer

SOFTWARE TASK ROLES

FINAL PLANS

Bridge Plans 
submittal will be in 

PDF form

Infraworks Master 
Model is the only 
model exported to 

Revit for plan sheets

PRIMARY: Engineer

SECONDARY: Detailer

Perform Clash Detection for the 
model

REVIT:
Create & Detail Bridge Plan 

Sheets

CIVIL 3D:
Create & Detail  Miscellaneous 

Items

INFRAWORKS:
Build 3D Bridge Model

INVENTOR:
Build 3D Bridge Components

NAVISWORKS:
Perform Clash Detection

AUTOCAD:
Create & Detail  Miscellaneous 

Items

PRIMARY: Detailer

SECONDARY: Engineer

Create and / or Modify existing
bridge components as necessary 

for use in Infraworks models

PRIMARY: Detailer

SECONDARY: Engineer

Print 2D Paper plans for check
PRIMARY: Detailer

SECONDARY: Engineer

Prepares Alignment, Terrain and 
Borings for Infraworks Model and 

Bridge Plan Sheets

Prepares Miscellaneous details 
and tables not done in Revit

Add reinforcing to 3D bridge 
model

Dimension and detail 3D bridge 
model and 2D plan sheets

PRIMARY: Detailer

SECONDARY: Engineer

PRIMARY: Detailer

SECONDARY: Engineer

Create 2D plan sheets

PRIMARY: Detailer

SECONDARY: Engineer

PRIMARY: Detailer

SECONDARY: Engineer

PRIMARY: Detailer

SECONDARY: Engineer

Export Model for Road Design 
plan use

PRIMARY: Detailer

SECONDARY: Engineer

Load alignment and terrain into 
model

Build proposals with alternate 
bridge designs

Export Model to Revit for 
detailing and reinforcing

Create PDF Plans and Merge 
with Standard Drawings

PRIMARY: Detailer

SECONDARY: Engineer

Places existing structure in 
model

Merges proposals and master 
models

Load additional features as 
necessary for design

PRIMARY: Detailer

SECONDARY: Engineer

PRIMARY: Detailer

SECONDARY: Engineer

PRIMARY: Detailer

SECONDARY: Engineer

PRIMARY: Detailer

SECONDARY: Engineer

PRIMARY: Detailer

SECONDARY: Engineer
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    

The following guide is to clip Open Roads terrain for use in Infraworks, Civil 3D and Revit. 

Download the following file from BIM360 

• XXXX000RDETR001.DGN (Open Roads Terrain file) 

 

OPEN ROADS 

TERRAIN CLIP 

Open the XXXX000RDETR001.DGN file 

Locate a rectangle or closed shape at the boundary of the area to be clipped. 

 

• From Civil Tools / Terrain Model 
o Create Clipped Terrain Model 

• Select the boundary of the existing terrain model 
• Next select the clipping boundary 

o This is the rectangle created earlier 
• Right click to reset 

 

 

Enter the appropriate values in the next 3 boxes 

 

Set Horizontal value = 0 

Left Click to accept 

 

Set Vetical Offset value = 0 

Left Click to accept 

 

Set Clipping Method to “External” 

Left Click to accept 

 

The terrain has now been clipped where the boundary lines intersected the existing terrain.  Use this new 
boundary line for exporting to Infraworks, Civil 3D and Revit. 
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